FlexNet Operations 2021.07 ALM Release Notes

July 2021

Introduction .......................................................................................................................................3

Resources ..........................................................................................................................................3

  Revenera Resources..........................................................................................................................3
  FlexNet Operations Videos..................................................................................................................4
  Previous FlexNet Operations Release Notes ......................................................................................4

Features and Enhancements ..............................................................................................................5

  Features and Enhancements in 2021.07...........................................................................................5
    Device Management Enhancements in 2021.07.................................................................................5
    Software Delivery Enhancements in 2021.07......................................................................................5
  Features and Enhancements in 2021.06...........................................................................................6
    Download Package Management Enhancements in 2021.06..............................................................6
    Electronic Software Delivery Enhancements in 2021.06.....................................................................7
    Entitlement Management Enhancements in 2021.06.......................................................................7
    License Management Enhancements in 2021.06...........................................................................8
  Features and Enhancements in 2021.05...........................................................................................8
    Device Management Enhancements in 2021.05.................................................................................8
    Entitlement Management Enhancements in 2021.05.......................................................................9
  Features and Enhancements in 2021.04...........................................................................................9
    Email Notification System Enhancements in 2021.04 .....................................................................9
  Features and Enhancements in 2021.03............................................................................................10
    Entitlement Management Enhancements in 2021.03.......................................................................10
  Features and Enhancements in 2021.02............................................................................................11
    SOAP and REST Web Services Enhancements in 2021.02...............................................................11
  Features and Enhancements in 2021.01............................................................................................11
    Entitlement Management Enhancements in 2021.01......................................................................12
    Export and Import Enhancements in 2021.01....................................................................................12
    Updates and Insights Enhancements in 2021.01..............................................................................12
    SOAP and REST Web Services Enhancements in 2021.01...............................................................13
    Rebranding in 2021.01.......................................................................................................................13

System Requirements......................................................................................................................13

Resolved Issues..................................................................................................................................14

  Issues Resolved in 2021.07..................................................................................................................14
    Device Management Issues Resolved in 2021.07.............................................................................15
    Email Notification System Issues Resolved in 2021.07.....................................................................15
    Product Management Issues Resolved in 2021.07...........................................................................15
    Software Delivery Issues Resolved in 2021.07................................................................................15
  Issues Resolved in 2021.06..................................................................................................................16
    Device Management Issues Resolved in 2021.06.............................................................................16
Entitlement Management Issues Resolved in 2021.06.............................................................................. 16
FlexNet Publisher Back-Office Issues Resolved in 2021.06.............................................................................. 16
General Issues Resolved Issues Resolved in 2021.06................................................................................... 17

Issues Resolved in 2021.05..................................................................................................... 17
Device Management Issues Resolved in 2021.05................................................................................... 17
Download Package Management Issues Resolved in 2021.05................................................................... 17
Electronic Software Delivery Issues Resolved in 2021.05............................................................................. 18
Product Management Issues Resolved in 2021.05..................................................................................... 18
Security Issues Resolved in 2021.05............................................................................................................. 18
SOAP and REST Web Services Issues Resolved in 2021.05........................................................................... 18

Issues Resolved in 2021.04..................................................................................................... 19
Device Management Issues Resolved in 2021.04................................................................................... 19
Email Notification System Issues Resolved in 2021.04.................................................................................. 19
Entitlement Management Issues Resolved in 2021.04.............................................................................. 20
License Usage Issues Resolved in 2021.04................................................................................... 20
SOAP and REST Web Services Issues Resolved in 2021.04........................................................................... 20

Issues Resolved in 2021.03..................................................................................................... 20
Account and User Management Issues Resolved in 2021.03....................................................................... 21
Email Notification System Issues Resolved in 2021.03.................................................................................. 21
Entitlement Management Issues Resolved in 2021.03.............................................................................. 21
Export and Import Issues Resolved in 2021.03................................................................................... 21
Product Management Issues Resolved in 2021.03..................................................................................... 22
Public Services Issues Resolved in 2021.03 ................................................................................................. 22
SOAP and REST Web Services Issues Resolved in 2021.03........................................................................... 22

Issues Resolved in 2021.02..................................................................................................... 23
Account and User Management Issues Resolved in 2021.02....................................................................... 23
Device Management Issues Resolved in 2021.02................................................................................... 23
Entitlement Management Issues Resolved in 2021.02.............................................................................. 24
License Management Issues Resolved in 2021.02.................................................................................. 24
Product Management Issues Resolved in 2021.02..................................................................................... 24
SOAP and REST Web Services Issues Resolved in 2021.02........................................................................... 25

Issues Resolved in 2021.01..................................................................................................... 25
Account and User Management Issues Resolved in 2021.01....................................................................... 25
Entitlement Management Issues Resolved in 2021.01.................................................................................. 26
Product Management Issues Resolved in 2021.01................................................................................... 26
User Experience Issues Resolved in 2021.01...................................................................................... 26

Known Issues .................................................................................................................................. 26
Special Notes .................................................................................................................................. 28
Legal Information ............................................................................................................................ 29
Introduction

This Release Notes document summarizes the features, enhancements, and updates delivered with FlexNet Operations 2021.07 in July 2021. The document includes the following information:

- Resources
- Features and Enhancements
- System Requirements
- Resolved Issues
- Known Issues
- Special Notes
- Legal Information

Resources

These resources are available for more information about FlexNet Operations and other Revenera products:

- Revenera Resources
- FlexNet Operations Videos
- Previous FlexNet Operations Release Notes

Revenera Resources

The following resources can help you stay up to date with FlexNet Operations news and product knowledge:

- In addition to providing case management, the Revenera Community site can help you quickly find answers to your questions by searching content from other customers, product experts, and thought leaders. You can also post questions on discussion forums for experts to answer. For each of Revenera's product solutions, you can access forums, blog posts, and knowledge base articles.

- You can find documentation for FlexNet Operations and all other Revenera products on the Revenera Product Documentation site.

- The Revenera Learning Center offers free, self-guided, online videos to help you quickly get the most out of your Revenera products. You can find a complete list of these training videos in the Learning Center.

- Customers who have purchased a maintenance contract for their product(s) can submit a support case or check the status of an existing case by making selections on the Get Support menu of the Revenera Community:

  https://community.revenera.com
FlexNet Operations Videos

These brief, informative videos walk you through the getting-started exercises found in the *FlexNet Operations User Guide* (online help or PDF version). We recommend that you first read the appropriate “Getting Started” section in the *User Guide* to gain an understanding of the concepts it covers, and then click the section title in the table below to view the video.

<table>
<thead>
<tr>
<th>Guide</th>
<th>Topics</th>
</tr>
</thead>
<tbody>
<tr>
<td>Getting Started with Entitlement Management</td>
<td>Creating an account, a user, a product, and an entitlement.</td>
</tr>
<tr>
<td>Getting Started with FlexNet Embedded Licensing</td>
<td>Setting up a publisher, identity, and a licensed product. Creating a device and activating its license. Creating and provisioning FlexNet Embedded license servers.</td>
</tr>
<tr>
<td>Getting Started with Electronic Software Delivery</td>
<td>Creating a producer and download packages, associating download packages with a product, creating files, associating files with download packages, and viewing and downloading files from the FlexNet Operations End-User Portal.</td>
</tr>
<tr>
<td>Getting Started with Usage Management</td>
<td>Creating a usage-based license model, a feature, a product, and an entitlement. Obtaining the license server URL to which the usage data is sent. Running a usage-capture client. Viewing usage information graphs and gauges.</td>
</tr>
<tr>
<td>Getting Started with FlexNet Publisher License File-Based Licensing</td>
<td>Activating and returning a certificate license.</td>
</tr>
<tr>
<td>Getting Started with Cloud Licensing Service</td>
<td>Creating a cloud-hosted license server.</td>
</tr>
<tr>
<td>Getting Started with FlexNet Customer Growth</td>
<td>Customer growth concepts and configuring notifications for expiring entitlements and expired entitlements.</td>
</tr>
</tbody>
</table>

Previous FlexNet Operations Release Notes

To access the release notes associated with previous FlexNet Operations ALM releases, do either of the following:

- To view all the release notes for 2021 ALM releases, access this location:
  https://docs.revenera.com/?product=FlexNet%20Operations&version=CURRENT

- To view the release notes associated with FlexNet Operations versions from previous years, access the following site and select the appropriate year.
  https://docs.revenera.com/?product=FlexNet%20Operations
Features and Enhancements

The following sections describe the new features and enhancements added to FlexNet Operations in 2021:

- Features and Enhancements in 2021.07
- Features and Enhancements in 2021.06
- Features and Enhancements in 2021.05
- Features and Enhancements in 2021.04
- Features and Enhancements in 2021.03
- Features and Enhancements in 2021.02
- Features and Enhancements in 2021.01

Features and Enhancements in 2021.07

Features and enhancements were added to the following areas of FlexNet Operations in the 2021.07 release:

- Device Management Enhancements in 2021.07
- Software Delivery Enhancements in 2021.07

Device Management Enhancements in 2021.07

The following enhancement to device management was added in the 2021.07 release.

**Ability to Modify Metered License Counts on Cloud License Servers**

In this release, it is now possible to change the counts of metered licenses mapped to Cloud license servers. This enhancement enables producers and end customers to increase, decrease, or completely remove the number of licenses mapped to a license server, within the count of licenses specified in an entitlement line item.

*Note* • It is not possible to modify counts of metered licenses mapped to local license servers.

Software Delivery Enhancements in 2021.07

Support for the delivery of containerized software is now available in the Software Delivery module in 2021.07. To enable this support, contact your Revenera representative.
Support for Containerized Software

In addition to distributing file-based software installers and updates, Software Delivery can now be used to distribute software applications that run in Docker containers and are deployed using Helm charts.

Management of Containerized Products

Like download files, producers distribute containerized applications by associating them with a download package. However, containerized applications are not stored in the FlexNet Operations database, but in a separate registry that is hosted by Revenera. Producers manage containerized applications by associating them with a download package in FlexNet Operations, and by tagging and pushing them to their corresponding project in the Revenera registry using a Docker or Helm client.

For more information about managing containerized applications, refer to the FlexNet Operations User Guide.

Distribution of Containerized Applications

Entitled customers can view the download packages and any associated Docker images or Helm charts in the End-User Portal. The End-User Portal also provides the path and pull command for downloading an image or chart directly from the registry. Customers must have a Docker or Helm client installed to be able to pull images or charts from the registry.

For more information about viewing and downloading packages for containerized applications, refer to the FlexNet Operations End-User Portal Help Library.

Features and Enhancements in 2021.06

Features and enhancements were added to the following areas of FlexNet Operations in the 2021.06 release:

- Download Package Management Enhancements in 2021.06
- Electronic Software Delivery Enhancements in 2021.06
- Entitlement Management Enhancements in 2021.06
- License Management Enhancements in 2021.06

Download Package Management Enhancements in 2021.06

The following enhancement to the management of download packages was added in the 2021.06 release.

SHA2 Checksum Available for Uploading Files

Previously, when preparing to upload a file for association with a download package, producers could provide the file’s expected MD5 value on the Upload File page. This value was then compared with the MD5 of the file once it was uploaded to ensure that the file had not changed during the upload.
Producers can now also provide the file’s expected SHA2 checksum value when performing an upload. They can provide both the SHA2 and the MD5 values or one or the other value to ensure that the pre-uploaded file and uploaded file are the same. Note that this SHA checksum option is available only when performing an HTTP or FTP upload (from the HTTP Upload or FTP Upload tab, respectively).

Electronic Software Delivery Enhancements in 2021.06

The following enhancements to Electronic Software Delivery (ESD) were added in the 2021.06 release.

Downloads Now Visible in End-User Portal for Users Who Reset Their Passwords

Previously, if an end-user’s account was deactivated due to multiple invalid login attempts and the user then reset their password, the Electronic Software Delivery module was not made aware of this account change. As a result, in the End-User Portal, the user could no longer view downloads associated with entitlements to which that user had access. Electronic Software Delivery will now be made aware of such changes, so that end users can continue to access downloads.

“Download Packages” Page Now Accessible for Multiple Selected Entitlement Line Items Belonging to Different Accounts

Prior to this release, when a user in the End-User Portal selected multiple entitlement line items belonging to various accounts and then clicked View > View Download Packages, the following error message was displayed: “The selected activation ids should belong to the same account Id.” The Download Packages page was not opened.

Now, when the user selects this option for multiple lines items belonging to various accounts, no error message is displayed. Instead, the Download Packages page is opened, enabling the user to view and download packages associated with these accounts. A dropdown above the grid on the page lets the user select the account for which to list download packages.

“Download Packages” Page Now Accessible for Multiple Selected Entitlement Line Items When Some Items Have No Downloads

Previously, when a user in the End-User Portal selected multiple entitlement line items—one or more of which had no associated download package—and then clicked View > View Download Packages, the following error message was displayed: “Some of the activation ids selected do not have download packages.” The Download Packages page was not opened.

Now, when the user selects this option for multiple lines items, some of which do not have associated download packages, no error message is displayed. Instead, the Download Packages page is opened, showing the download packages for those selected line items that have packages. However, if none of the selected line items are associated with download packages, the error message is displayed.

Entitlement Management Enhancements in 2021.06

The following enhancement to entitlement management was added in the 2021.06 release.
Improved User Experience When Attempting to View Download Packages for Entitlements Without Associated Downloads

Users on the List Entitlements page in the End-User Portal can select View > View Download Packages to view and download the download packages associated with multiple entitlement line items currently selected on the List Entitlements page.

Previously, if any of the selected line items were not associated with a download package, users received an error message, forcing them to deselect those line items that had no associated download packages before they could proceed to view the download packages for those items that had. (Entitlement line items that have an associated download show a Download Now link in the Downloads column on the List Entitlements page.)

Now, when users select to view the download packages for multiple line items, some of which do not have an associated download, the Download Packages window proceeds to open, listing the downloads for only those line items that have associated downloads. The previous error message that prevented users from proceeding to view the Download Packages window is no longer presented.

If none of the selected line items have associated download packages, a pop-up message on the List Entitlements page lets you know.

License Management Enhancements in 2021.06

The following enhancement to license management was added in the 2021.06 release.

Search Filters in End-User Portal Enhanced to Obtain Active Fulfillments

The List Licenses page in the End-User Portal now provides additional Advanced Search filters that can be used to obtain a list of all active license fulfillments. This can be useful, for instance, when consolidating fulfillments because all fulfillments consolidated must be active. To obtain this list, users will need to use a combination of the new fulfillment State filter (Active) and the new Line Item State filter (Deployed).

Features and Enhancements in 2021.05

Features and enhancements were added to the following areas of FlexNet Operations in the 2021.05 release:

- Device Management Enhancements in 2021.05
- Entitlement Management Enhancements in 2021.05

Device Management Enhancements in 2021.05

The following enhancement to device management was added in the 2021.05 release.
Site Name Now Editable After Device Creation

The Site Name property for a standalone or server device enables the user to identify a sub-section of a company account, such as the location to which a device is delegated. Previously, this field was available when creating the device. However, once the device was created, users could no longer edit this value.

In this release, the Site Name field is now editable after a device is created in either the Producer Portal or the End-User Portal. To allow editing of this field in the End-User Portal, the system administrator must select the new configuration setting, Allow site name editing, under System > Configure > End-User Portal Setup > Devices Page.

This setting is processed only when the Display Site Name in device pages is also selected.

Entitlement Management Enhancements in 2021.05

The following enhancement to entitlement management was added in the 2021.05 release.

Entitlement Search by Contact Email Address

Users can now filter entitlements by the email address of the contact associated with the sold-to account for entitlements. The following new items are available to enable the use of this new filter:

- A new Contact Email option in the Search for field on the List Entitlements by Order page
- A new optional contactEmail parameter for the getEntitlementsQuery method in the V4 EntitlementOrderService web service.

Note • For partner accounts, the search base on the contact email address works for those accounts that belong to the endCustomer tier type.

Features and Enhancements in 2021.04

Features and enhancements were added to the following areas of FlexNet Operations in the 2021.04 release:

- Email Notification System Enhancements in 2021.04

Email Notification System Enhancements in 2021.04

The following enhancement was added to the Email Notification system in 2021.04.
Support for Account-level Custom Attributes in Entitlement, Entitlement Certificate, and Reset Password Email Templates

The Entitlement, Entitlement Certificate, and Reset Password email templates now support account-level custom attributes. One or more of the custom attributes can be used to define conditions in the template that control the content sent to the users of different accounts. The templates include FOR-EACH tags that can be used to iterate through the accounts to read the values of the custom attributes.

Features and Enhancements in 2021.03

Features and enhancements were added to the following areas of FlexNet Operations in the 2021.03 release:

- Entitlement Management Enhancements in 2021.03

Entitlement Management Enhancements in 2021.03

The following enhancement to entitlement management was added in the 2021.03 release.

Multiple Package Downloads from Entitlement List in End-User Portal

Previously, users were required to perform software downloads for entitlement line items on the List Entitlements page one line item at a time. In this release, users can now perform software package downloads for multiple line items selected on the List Entitlements page or opt to download selected files within a given download package. (All selected entitlement line items must belong to the same account and have downloads available.)

To initiate the download process, users select the new View > View Download Packages option on the List Entitlements page. This option opens the Download Packages window, enabling users to view a list of the software download packages available for the selected line items and then download selected (or all) packages. Alternatively, users can click a package link from this window to obtain a list of all the files contained in the package, and, from this list, select specific (or all) files to download. Compliance checks are performed before any download starts.

Users must have the existing Get Downloads permission to perform these software downloads.

The new View Download Packages option is not visible by default, but is enabled by means of a new system configuration setting in the Producer Portal, System > Configure > End-User Portal Setup > Entitlements Page > Show View Download Packages.

Similarly, the button to download all files for selected packages directly from the Download Packages window is enabled by a separate system configuration setting, System > Configure > End-User Portal Setup > General Options > Show Download Button. This setting is applied only if the previously described Show View Download Packages option is enabled.
Features and Enhancements in 2021.02

Features and enhancements were added to the following areas of FlexNet Operations in the 2021.02 release:

- SOAP and REST Web Services Enhancements in 2021.02

SOAP and REST Web Services Enhancements in 2021.02

The following enhancement to the Web Services module was added in the 2021.02 release.

New Data Access REST Interface

This release introduces a new set of Data Access REST APIs that enable producers to capture a complete view of FlexNet Operations data for their tenant.

Current data-extraction APIs capture only incremental information from the FlexNet Operations warehouse, which is hosted and maintained by Flexera. To obtain a complete view of the data for reporting purposes, producers must host and maintain an archive of the data warehouse in their own database, regularly extracting data from the FlexNet Operations data warehouse and merging it with the archive to keep the data up to date.

Using the new APIs, however, producers can now extract data for their tenant from any time period directly from the FlexNet Operations data warehouse, eliminating the need to maintain an archive. Additionally, these APIs offer an alternative to the existing FlexNet Operations Reporter tool, providing programmatic access to data and a standard interface on which it is possible to build custom reporting tools and integrate the data into any web or mobile application.

These APIs retrieve data related to the following:

- Accounts
- Users
- Entitlements
- Fulfillments
- Devices
- Served devices

For more information about the new Data Access REST APIs, refer to the FlexNet Operations Web Services Integration Guide.

Features and Enhancements in 2021.01

Features and enhancements were added to the following areas of FlexNet Operations in the 2021.01 release:

- Entitlement Management Enhancements in 2021.01
- Export and Import Enhancements in 2021.01
- Updates and Insights Enhancements in 2021.01
Entitlement Management Enhancements in 2021.01

The following enhancement to the entitlement management was added in the 2021.01 release.

New Parameter to Control Inactivating or Obsoleting Entitlements and Line Items Currently Used by Devices

When an entitlement or line item is made Inactive or Obsolete, the licenses currently activated on a device (license server or standalone device) by that line item or entitlement remain on the device until they expire.

If this behavior is not desired, it is now possible to prevent the line item or entitlement from being made Inactive or Obsolete by setting the System Configuration option Allow used entitlement/line item state change to Inactive or Obsolete to false. An error message will then be displayed if an attempt is made to make such a line item or entitlement Inactive or Obsolete. (The option is located under System>Configuration>FlexNet Operations>General Options.)

Export and Import Enhancements in 2021.01

The following enhancement to the Data Export and Import functionality was added in the 2021.01 release.

Ability to Export a Single Entitlement into a Template for Import

Previously, to import a single or selected entitlements into a template for data import, users had to export the entire entitlement base. A new import option now makes it possible to export selected entitlements into a template for import.

Updates and Insights Enhancements in 2021.01

The following enhancement to the Updates and Insight module was added in the 2021.01 release.

Support for Served Devices

Updates and Insights originally supported requests from standalone devices only and then, starting in 2020 R2 SP1, from server devices. With this current release, Updates and Insights will also accept update requests (and the ability to log update status and device events) from served devices. This enhancement enables served devices to carry out in-product updates—and so achieve more frequent updates or patches to their software—as well as provide producers with insights into the status and use of their software on served devices.
SOAP and REST Web Services Enhancements in 2021.01

The following enhancement to the Web Services module was added in the 2021.01 release.

Ability to Search by “Sold To” Account Name When Using “getEntitlementsQuery”

Previously, the getEntitlementsQuery SOAP web service did not allow the ability to filter on the Sold To account name. An optional parameter, isSearchByName, has been added to the request type so that this filter can be carried out, without changing the way the API operates by default for existing integrations.

Rebranding in 2021.01

In 2020, FlexNet Operations became a product of Revenera, a new division of Flexera Software. The process is currently underway to rebrand the product, user documentation, and related artifacts to display the new Revenera logo (replacing the “Flexera” logo) and to redirect links to the Revenera Community and other Revenera-related sites. The FlexNet Operations product name remains the same.

System Requirements

Detailed system requirements for FlexNet Operations include the following.

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Web browsers</td>
<td>• Microsoft Edge</td>
</tr>
<tr>
<td></td>
<td>• Mozilla Firefox 75.0</td>
</tr>
<tr>
<td></td>
<td>• Google Chrome 80.0.3987.163</td>
</tr>
<tr>
<td>FlexNet licensing module</td>
<td>• FlexNet Publisher Toolkit 11.12.0 or later</td>
</tr>
<tr>
<td></td>
<td>• FlexNet Embedded Toolkit 2015 R2 or later</td>
</tr>
</tbody>
</table>

*Note* • FlexNet Operations supports these FlexNet Embedded host ID types: Ethernet, FlexID 9, FlexID 10, String, VM_UUID, User, Extended, PUBLISHER_DEFINED, Internet, *and* Internet6.
Resolved Issues

The following sections describe the issues that have been resolved in the FlexNet Operations 2021 releases to date:

- Issues Resolved in 2021.07
- Issues Resolved in 2021.06
- Issues Resolved in 2021.05
- Issues Resolved in 2021.04
- Issues Resolved in 2021.03
- Issues Resolved in 2021.02
- Issues Resolved in 2021.01

Issues Resolved in 2021.07

Issues in the following areas were resolved in the FlexNet Operations 2021.07 release:

- Device Management Issues Resolved in 2021.07
- Email Notification System Issues Resolved in 2021.07
- Product Management Issues Resolved in 2021.07
- Software Delivery Issues Resolved in 2021.07

Vendor certificate generator

The current versions of the VCG kit are 12.11.0 and 16.2.2.0. These VCGs were tested with the following compilers:

- Linux—gcc 4.1.2 (RHEL 5.0)
- Linux—gcc 4.4.4 (RHEL 6.0)

Note • The 12.11.0 VCG is built with FlexNet Publisher 11.11.1 and shares the same minimum C compiler requirements on each supported platform. (See the FlexNet Publisher 11.11.1 release notes for C/C++ compiler support.)

High Speed File Upload

If you intend to use the High Speed Upload option to upload files, the following plug-in is required:

Aspera Connect 3.10.0 or later

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vendor certificate generator</td>
<td>The current versions of the VCG kit are 12.11.0 and 16.2.2.0. These VCGs were tested with the following compilers:</td>
</tr>
<tr>
<td></td>
<td>• Windows—Visual Studio 2010 Professional Edition</td>
</tr>
<tr>
<td></td>
<td>• Linux—gcc 4.1.2 (RHEL 5.0)</td>
</tr>
<tr>
<td></td>
<td>• Linux—gcc 4.4.4 (RHEL 6.0)</td>
</tr>
</tbody>
</table>

Note • The 12.11.0 VCG is built with FlexNet Publisher 11.11.1 and shares the same minimum C compiler requirements on each supported platform. (See the FlexNet Publisher 11.11.1 release notes for C/C++ compiler support.)
Device Management Issues Resolved in 2021.07

The following issue was resolved for the management of devices in the 2021.07 release.

Details for Served Devices Now Visible to Partners

Partner users in the End-User Portal (or using SOAP web services) are now able to view the details of a device whose features are served by a license server belonging to a customer account associated with the partner. This capability exists as long as the license server is licensed with an activation ID that is mapped to both the partner’s account and the customer’s account. Previously, partners could not view served-device details in an associated customer account.

Email Notification System Issues Resolved in 2021.07

The following issue was resolved for the Email Notification system in the 2021.07 release.

CLS Identification Merge Tags Now Supported in Email Forms in End-User Portal

The merge tags `[[DEFAULT_GLS_INSTANCE_ID]]` and `[[DEFAULT_GLS_URL]]`—which identify a Cloud license server (CLS)—are now supported in the email form used in the End-User Portal to send entitlement notifications.

Product Management Issues Resolved in 2021.07

The following issue involving product management was resolved in the 2021.07 release.

New Product Information No Longer Overwriting Existing Product Information

When a producer was creating a product while an existing product was currently open in the same browser session, the information saved for the new product could overwrite certain information in the existing product (as seen when the existing product was refreshed). This issue is now resolved. Information for an opened existing product is no longer overwritten with information from a product being created in the same browser session.

Software Delivery Issues Resolved in 2021.07

The following issue related to Software Delivery was addressed in the 2021.07 release.

“Extended Description” Field on “Add File” Page Returned to Its Previous Maximum Length

An issue was reported in the 2021.06 release that the maximum size for the Extended Description field on the Add File page had changed from 1000 to 2000 characters. In this release, the field’s previous 1000-character maximum size has been restored.
Issues Resolved in 2021.06

Issues in the following areas were resolved in the FlexNet Operations 2021.06 release:

- Device Management Issues Resolved in 2021.06
- Entitlement Management Issues Resolved in 2021.06
- FlexNet Publisher Back-Office Issues Resolved in 2021.06
- General Issues Resolved Issues Resolved in 2021.06

Device Management Issues Resolved in 2021.06

The following issue was resolved for the management of devices in the 2021.06 release.

**Additional Improvement in the Enforcement of User Permissions When Editing Devices**

In the 2021.04 release, a change was included to allow strict enforcement of a customer user’s permissions in the End-User Portal, where the user’s permissions might vary between accounts. (This enforcement is enabled using the option System > Configure > End-User Portal Setup > Devices Page > Enforce device management permission across accounts.)

In this release, a further improvement has been applied to this change, so that if a user lacks permissions to return or generate licenses, but can otherwise edit a device, these specific restrictions are also enforced strictly for each account.

Entitlement Management Issues Resolved in 2021.06

The following issues were resolved for entitlement management in the 2021.06 release.

**Activation ID Link Now Properly Opening Entitlement Details Window**

In the End-User Portal, clicking an activation ID on the List Entitlements page resulted in an error message. This issue has been resolved. Now, clicking an activation ID link opens the Entitlement Details window, which lists the activation details.

**Bulk Upgrades with Embedded Licenses Successful**

Bulk upgrade jobs complete without errors related to embedded licenses.

FlexNet Publisher Back-Office Issues Resolved in 2021.06

The following FlexNet Operations issue related to the FlexNet Publisher was addressed in the 2021.06 release.

**Creation of Trial ASRs No Longer Resulting in Hibernation Error**

Previous attempts to create local trial ASRs could result in a hibernation error if the ASR requested features with long names or a large number of features. This issue has now been resolved.
General Issues Resolved Issues Resolved in 2021.06

The following general issue related to FlexNet Operations was addressed in the 2021.06 release.

Third-Party Component jQuery Upgrade

The UI for the third-party component jQuery has been upgraded to 1.12.1 for both the Producer Portal and the End-User Portal to resolve any issues related to the outdated product.

Issues Resolved in 2021.05

Issues in the following areas were resolved in the FlexNet Operations 2021.05 release:

- Device Management Issues Resolved in 2021.05
- Download Package Management Issues Resolved in 2021.05
- Electronic Software Delivery Issues Resolved in 2021.05
- Product Management Issues Resolved in 2021.05
- Security Issues Resolved in 2021.05
- SOAP and REST Web Services Issues Resolved in 2021.05

Device Management Issues Resolved in 2021.05

The following issue was resolved for the management of devices in the 2021.05 release.

Trailing or Leading Spaces in Feature Names No Longer Failing Device Series Updates

Previously, when producers attempted to update a device series for FlexNet Embedded, any trailing or leading spaces around a feature name prevented the series from being updated. Starting in this release, trailing or leading spaces around feature names are ignored during the update process.

Download Package Management Issues Resolved in 2021.05

The following issue was resolved for the management of download packages in the 2021.05 release.

Size of Files in Download Packages Now in Binary Format

Previously, the size of files in a download package on the Downloads > List Downloads page did not match the size of the downloaded files. In this release, file sizes in the End-User Portal are now calculated using a binary conversion so that the raw byte size is divided by a power of 2 rather than a power of 10, as used previously. For example, with this conversion 1 KB now represents 1024 bytes, rather than the 1000 bytes previously calculated. As a result, the Downloads > List Downloads page now shows the size of files in the download package in binary format, the same format used for downloaded-file sizes, thus eliminating the file-size discrepancies.

Note that the Reporter still calculates file sizes using a power of 10 so that 1 KB represents 1000 bytes.
Electronic Software Delivery Issues Resolved in 2021.05

The following issue related to Electronic Software Delivery was addressed in the 2021.05 release.

“List Entitlements” Page Now Showing Download Package Links for Re-identified Entitlements

Previously, if an entitlement that had an associated download package was re-identified with an auto-generated entitlement ID, the List Entitlements did not show the package-download link in the End-User Portal. This issue has now been resolved.

Product Management Issues Resolved in 2021.05

The following issue was resolved for the management of download packages in the 2021.05 release.

Last Modified Date Now Updated Only When Product Configuration Changes Saved

Previously, simply navigating through the details for a product resulted in the product’s Data Modified field to be updated. Now the field is updated only if the changes to the product’s configuration have been saved.

Security Issues Resolved in 2021.05

The following security issue was addressed in the 2021.05 release.

Restricted Directory Access

As a preventative measure based on a recently announced security vulnerability, a security constraint has been implemented to restrict access to the WEB-INF directory.

SOAP and REST Web Services Issues Resolved in 2021.05

The following issue related to FlexNet Operations web services was addressed in the 2021.05 release.

Appropriate Error Now Produced When Transferred Counts Exceed Available Counts

Previously, the transferLineItem method in the EntitlementOrderService SOAP web service erroneously permitted the transfer of line item counts from one entitlement to another when the requested transfer count was greater than the number of licenses available in the source entitlement.

Now, the transferLineItem method throws an appropriate error when users attempt to transfer line item counts that exceed the number of licenses available in the source entitlement. (The transfer succeeds, however, when the transfer count is less than or equal to the available license count.)
Issues Resolved in 2021.04

Issues in the following areas were resolved in the FlexNet Operations 2021.04 release:

- Device Management Issues Resolved in 2021.04
- Email Notification System Issues Resolved in 2021.04
- Entitlement Management Issues Resolved in 2021.04
- License Usage Issues Resolved in 2021.04
- SOAP and REST Web Services Issues Resolved in 2021.04

Device Management Issues Resolved in 2021.04

The following issue was resolved for the management of devices in the 2021.04 release.

Device Permissions Now Properly Enforced Based on Its Account

Previously, a user who belonged to multiple accounts—one or more of which had full device-management permissions—would have full device-management permissions on devices that belonged to any of these accounts, even those accounts in which the user had no or limited device-management permissions.

A new configuration option in the Producer Portal, System > Configure > End-User Portal Setup > Devices Page > Enforce device management permission across accounts, now enforces device management permissions across all accounts in the End-User Portal. When the option is selected, all devices are listed on the Devices page (as in previous releases), no matter the account with which a given device is associated. However, when a device link is clicked, the capabilities available on the Device Details page are based on the specific account to which the device belongs. Consequently, if a user belongs to multiple accounts, the user’s device-management permissions are now determined on an account-by-account basis, depending on the account with which the currently selected device is associated.

By default, this option is unselected so that the previous behavior remains in effect.

Email Notification System Issues Resolved in 2021.04

The following issues were resolved for the Email Notification system in the 2021.04 release.

Issues with Account Keywords and Merge Tags

Previously, the Entitlement and Entitlement Certification email template had the following issues:

- The Account keyword was not retrieving account-related merge tag details.
- The merge tag \[AcctName]\] retrieved no information, resulting in a blank in the generated email or certificate.

These issues have been resolved in the current templates.
Title Length Errors for Template Variations Now Properly Handled

Previously, when users created an email template variation with a title that exceeded the maximum 25 characters, FlexNet Operations did not handle the error in a helpful way. A meaningful error message is now provided.

Entitlement Management Issues Resolved in 2021.04

The following issue related to entitlement management was resolved in the 2021.04 release.

Correct Available Count Showing on Entitlement Transfer Page

The Transfer Entitlement Line Item page now displays the correct available count for the transfer of an entitlement line item from a source to a target account in both the Producer Portal and the End-User Portal.

License Usage Issues Resolved in 2021.04

The following issue related to license usage was resolved in the 2021.04 release.

Issues with Activation ID Case Sensitivity in License Usage Searches Resolved

Previously, the case-sensitivity issues occurred with the activation IDs provided during searches for license usage information on devices. License usage searches are now case insensitive.

SOAP and REST Web Services Issues Resolved in 2021.04

The following issue with SOAP and REST web services was resolved in the 2021.04 release.

Feature Replacement for Deployed Products Now Working Properly

The REPLACE operation for individual features in the updateProduct SOAP web service now properly replaces a given feature in a deployed project (as long as the editing of deployed products is allowed).

Issues Resolved in 2021.03

Issues in the following areas were resolved in the FlexNet Operations 2021.03 release:

- Account and User Management Issues Resolved in 2021.03
- Email Notification System Issues Resolved in 2021.03
- Entitlement Management Issues Resolved in 2021.03
- Export and Import Issues Resolved in 2021.03
- Product Management Issues Resolved in 2021.03
- Public Services Issues Resolved in 2021.03
Account and User Management Issues Resolved in 2021.03

The following issue was resolved for the management of accounts and users in the 2021.03 release.

Creation of Users with Email Address Domains Containing Four Parts Now Allowed

The End-User Portal now allows the creation of users whose email address contains four tokens in its domain part (such as in mary.smith@a.b.example.com).

Email Notification System Issues Resolved in 2021.03

The following issue was resolved for the Email Notification system in the 2021.03 release.

Issue with Incorrect First Names Used in Emails Resolved

Previously, when an account had multiple users, a notification email sent to any of these users could contain the first name of any of the account's users in the greeting. This issue has been resolved so that the correct first name of a given recipient is used in that recipient's email.

Entitlement Management Issues Resolved in 2021.03

The following issue involving entitlement management was resolved in the 2021.03 release.

Attempts to Reduce Entitlement Quantities Now Successful

In some cases previously, producers were not able to reduce the quantity of a line item for a FlexNet Embedded entitlement even though the entitlement had no active fulfillments or still had some line items yet to be fulfilled. (The issue was related to FlexNet Embedded entitlements created before December 3, 2020.) This issue has now been resolved.

Export and Import Issues Resolved in 2021.03

The following issue related to the Data Export and Import functionality was resolved in the 2021.03 release.

Downloads Now Available to End Users for Entitlements Created with Data Import Template

Previously, when entitlements were created using a data import template, an Electronic Software Delivery download link would be available in the End-User Portal for only the last line item of each entitlement. This issue has been resolved so that links to all items in the entitlement are available.
Product Management Issues Resolved in 2021.03

The following issue related to product management was resolved in the 2021.03 release.

**Product Line Change No Longer Deleting Custom Attributes of Product**

Previously, if you changed the product line for a given product, all the custom attributes for the product were deleted. This behavior is now managed by a new attribute, System > Configure > FlexNet Operations > Preserve Product Custom Attributes when changing a Product Line. By default, this option is not selected.

Public Services Issues Resolved in 2021.03

The following issue involving the Public Services was resolved in the 2021.03 release.

**“EntitlementDetails” Public Service No Longer Generating Error for Missing Grace Period**

A license model can designate that the value for certain attributes (such as Grace Period, Renewal, Overdraft) be defined at the time an entitlement line is created for any product to which the license model is assigned. Additionally, providing a value for this attribute is optional. When the EntitlementDetails public service was run against an entitlement containing entitlement lines that had no value defined for one of these attributes, the service generated an error message similar to this: “The attribute <attribute name> days is not a valid numeric type.”

This issue has been resolved so that, when an attribute that is designated as optional for an entitlement line has no value, the EntitlementDetails public service no longer throws an exception.

SOAP and REST Web Services Issues Resolved in 2021.03

The following issues with SOAP and REST web services were resolved in the 2021.03 release.

**Part Number Associated with Product Now Properly Handled During Product Entitlement**

Previously, if the part number for a product that was being entitled was not included during the creation of an entitlement through the EntitlementOrderService SOAP web service, the part number associated with the product was still shown in the End-User Portal. This has been fixed. Now, if the part number for a product being entitled is not included in the web service request, the part number associated with the entitled product is no longer assigned by default.

**Milliseconds Separator No Longer Included in Returned Usage Data**

In the data returned for the Usage data extract REST API, the timestamps for Transaction Time and Received Time were showing a period (.) as a milliseconds separator even though a milliseconds value was not intended to be included in either timestamp.

2020-08-18T02:09:28.-0700

The unnecessary period could cause parsing issues and has now been removed.
Last Modified Time for Line Items Now Reported Accurately

The `lastModifiedDateTime` attribute for an entitlement line item now gets updated internally with every checkout or return of a license. As a result, this value (in UTC format) is now accurately reported in the `lastModifiedDateTime` field in the response for the `getActivatableItemsQuery` SOAP web service.

Issues Resolved in 2021.02

Issues in the following areas were resolved in the FlexNet Operations in the 2021.02 release:

- Account and User Management Issues Resolved in 2021.02
- Device Management Issues Resolved in 2021.02
- Entitlement Management Issues Resolved in 2021.02
- License Management Issues Resolved in 2021.02
- Product Management Issues Resolved in 2021.02
- SOAP and REST Web Services Issues Resolved in 2021.02

Account and User Management Issues Resolved in 2021.02

The following issue was resolved for the management of accounts and users in the 2021.02 release.

**Users Now View Only Those Accounts to Which They Belong**

Previously, when the Apply Manage Users... system option was in effect, a user (for example, User 1), who belonged to the same account as another user (User 2), would be able to remove User 2 from a different account even if User 1 did not belong to the different account. This issue has now been resolved by providing a user with access to only those accounts to which the user belongs.

The Apply Manage Users permission to users in shared accounts option is configured through System > Configure > FlexNet Operations > General Options in the Producer Portal.

Device Management Issues Resolved in 2021.02

The following issue was resolved for the management of devices in the 2021.02 release.

**Now Only Electronic Software Delivery License Required for Availability of Downloads Tab for Devices**

The Downloads tab is visible on the Device Details page for a standalone device in the End-User Portal as long as the end user has an Electronic Software Delivery license (and the Administrator has set the appropriate System Configuration options for the End-User Portal). Previously, the visibility of this tab was erroneously dependent on an Updates and Insights license as well.
Entitlement Management Issues Resolved in 2021.02

The following issues involving entitlement management were resolved in the 2021.02 release.

Issue with Deleting Source Account in an Entitlement Merge Resolved

Previously, after the entitlements for an account belonging to one organization had been merged with the entitlements of another account for a different organization on the same host, an attempt to delete the source account for the merge could fail. The deletion of the source account now completes successfully.

Users with Italian Locale Now Able to Perform Entitlement Transfers

Previously, users with the locale value Italian (it_IT) were unable to transfer entitlements in the End-User Portal. This issue has been resolved.

Returned FlexNet Publisher Licenses Now Reflected in Line Item Counts

Previously, counts for returned FlexNet Publisher licenses were not being updated to the associated entitlement line items. This issue has been resolved.

Correct “Available Quantity” Values Now Show in Line Items in End-User Portal

Line items for FlexNet Embedded entitlements on the List Entitlements page in the End-User Portal now display correct values for Available Quantity (for example, when compared with the correct Qty Remaining value on the Entitlement Details pop-up). This issue was found in those FlexNet Embedded entitlements that were created and fulfilled before December 3, 2020.

License Management Issues Resolved in 2021.02

The following issue involving license management was resolved in the 2021.02 release.

Unexpected Error During Creation of Local Trial ASRs Resolved

Previous attempts to create a local trial ASR in the Producer Portal could fail with an unexpected error. The error is resolved, and the creation of a local trial ASR now completes successfully.

Product Management Issues Resolved in 2021.02

The following issue related to product management was resolved in the 2021.02 release.

License Model Value for Product Part Number Now Updating Properly

Previously, when a different product was associated with a part number on the Create a Part Number window, the License Model selected for the new product was not saved once the user clicked Save. This issue is now resolved.
SOAP and REST Web Services Issues Resolved in 2021.02

The following issues with SOAP and REST web services were resolved in the 2021.02 release.

“getActivatableItemsQuery” Web Service Results Now Show Correct Number of Copies for Line Items

Previously, in the response for the getActivatableItemsQuery SOAP web service, information for given entitlement line items could occasionally show out-of-date values for the number of remaining and fulfilled line-item copies. This issue is now resolved.

Special “publicservices” REST API Now Returning Correct License Counts

The publicservices REST API is a special interface used by some producers to return license counts for an activation or entitlement ID.

Previously, this API could return an incorrect “remaining licenses” count for a given activation ID. If the API was called as part of an activation process, the incorrect value in the response could cause the activation to fail. The publicservices API is now returning the correct license counts for a given activation ID.

Issues Resolved in 2021.01

Issues in the following areas were resolved in the FlexNet Operations the 2020.01 release:

- Account and User Management Issues Resolved in 2021.01
- Entitlement Management Issues Resolved in 2021.01
- Product Management Issues Resolved in 2021.01
- User Experience Issues Resolved in 2021.01

Account and User Management Issues Resolved in 2021.01

The following issues involving the management of accounts and users were resolved in the 2021.01 release.

Attempt to Delete a User Associated with Many Devices Now Completes Successfully

Previously, when a user was associated with a large number of devices, a request to the FlexNet Operations UI or Web Services to delete the user occasionally failed because an internal operation timed out. The internal operation has been optimized so that it no longer times out, enabling the delete process to complete successfully.

Buttons on User Creation Page No Longer Disappearing

The Link Account and Remove Account buttons no longer erroneously disappear on the Create a User page when the pagination button is clicked.
Entitlement Management Issues Resolved in 2021.01
The following issue involving entitlement management was resolved in the 2021.01 release.

Changes to Line Items Now Shown on License Server
Previously, in some cases when a line item was updated (for example, to extend an expiration date), the changes to the line item were not displaying on the relevant license server. The situations that caused this issue have now been resolved.

Product Management Issues Resolved in 2021.01
The following issue involving product management was resolved in the 2021.01 release.

Successful Product Mapping to a Product Line with a Multi-Line Attribute
Previously, when a product line had an attribute whose type was multi-line, users could not map products to the product line. This issue has been resolved.

User Experience Issues Resolved in 2021.01
The following issue involving user experience was resolved in the 2021.01 release.

Text in the FlexNet Operations End-User Portal Now Properly Localized
Certain error and confirmation messages, input field labels, and instructions in the FlexNet Operations End-User Portal were not being properly localized. These localization issues have now been resolved.

Known Issues
The following describes known issues in the current FlexNet Operations release.

SWM-7952: Not all applicable download links available on List Downloads page in End-User Portal
When end-users are logged in with an activation ID for an entitlement line item that is associated with multiple products, the Downloads > List Downloads page in the End-User Portal does not always show links to all applicable product downloads.

SWM-7786: SHA2 Checksum Value of Previous File Shown
The following issue can be observed in the 2021.06 release, following the SHA2 Checksum Available for Uploading Files enhancement, where a file's expected SHA2 checksum value can be provided when performing an upload. If a file image is subsequently deleted, and the Upload File page is opened again, the SHA2 checksum value of the previously loaded file image is shown.
SWM-6996: Updating device “Site name” property to blank not handled properly

If you change the Site name value for a device to a blank, the edited property reverts to its original value instead of maintaining the blank. This issue occurs when you make the change either through the Devices UI in the Producer Portal or End-User Portal or through the updateDevice method in the ManageDeviceService SOAP web service.

SWM-5894: Changes and limitations to the updateDevice SOAP method

The updateDevice method in the V3 and V4 ManageDeviceService SOAP web service has the following limitations and changes:

- Single channel partner recommended in channel partner list
- Support for only Replace operation in channel partner list

Single channel partner recommended in channel partner list

As in previous releases, the updateDevice method supports a list of channel partners. However, because a device is currently limited to one channel partner, the web service code, in turn, considers only one channel partner for the method. Therefore, you are strongly recommended to include only one partner in the channel partner list. If the list contains more than one channel partner, the behavior of updateDevice method is unpredictable.

Support for only Replace operation in channel partner list

Previously, the opType element, required for managing a channel partner list for the updateDevice method, had three possible values: Add, Delete, or Replace. This element now supports only the Replace value. If you specify Add, Delete, or Replace or omit the element altogether, the method will always use Replace. (If you attempt to specify Add or Delete, a message is returned in the response, explaining that Replace was used instead.)

FNO-63827: Downloads sometimes not available to end users when accounts are re-identified

When a new account is set up with an account ID previously used by a different account, and a user who belonged to the original account is assigned to the new account, that user is unable to see Software Delivery download links in the End-User Portal.

FNO-61266: Translation issues with localization

Per a previous enhancement in 2020 R3 to add more language support for End-User Portal localization, certain strings—such as alerts and validation messages—are not being translated properly when localization is in effect. These issues will be addressed in an upcoming release.

FNO-60845: Size limitation for license models

The JSON definition of a license model and the definition’s internal representation are both stored in the FlexNet Operations database. Neither the JSON definition nor its internal representation can exceed 8000 bytes in length.
Special Notes

This section contains special information pertaining to FlexNet Operations.

Plug-in Upgrade Needed for High-Speed File Uploads

If you intend to use the high-speed upload option to upload files, upgrade the Aspera plug-in to Aspera Connect 3.10.0 or later.

Best Practice for Uploading New File Versions for Software Delivery

The following practice helps to prevent the delivery of “stale” file content to your customers.

When you upload a new version of a file (or package) whose previous version exists in the Software Delivery system, best practice is to give the new file version a unique name, different from the name of the existing file version. (For example, use a version number in the file name.) Try to avoid simply uploading a file using the same name as the existing file so that the existing file is overwritten.

If you must upload a new file using the same name as the existing file, delete the existing file and wait 10-15 minutes before uploading the new version. This process will reduce the probability of re-caching the old content.
Legal Information

Copyright Notice

Copyright © 2021 Flexera Software

This publication contains proprietary and confidential information and creative works owned by Flexera Software and its licensors, if any. Any use, copying, publication, distribution, display, modification, or transmission of such publication in whole or in part in any form or by any means without the prior express written permission of Flexera Software is strictly prohibited. Except where expressly provided by Flexera Software in writing, possession of this publication shall not be construed to confer any license or rights under any Flexera Software intellectual property rights, whether by estoppel, implication, or otherwise.

All copies of the technology and related information, if allowed by Flexera Software, must display this notice of copyright and ownership in full.

FlexNet Operations incorporates software developed by others and redistributed according to license agreements. Copyright notices and licenses for these external libraries are provided in a supplementary document that accompanies this one.

Intellectual Property

For a list of trademarks and patents that are owned by Flexera Software, see https://www.revenera.com/legal/intellectual-property.html. All other brand and product names mentioned in Flexera Software products, product documentation, and marketing materials are the trademarks and registered trademarks of their respective owners.

Restricted Rights Legend

The Software is commercial computer software. If the user or licensee of the Software is an agency, department, or other entity of the United States Government, the use, duplication, reproduction, release, modification, disclosure, or transfer of the Software, or any related documentation of any kind, including technical data and manuals, is restricted by a license agreement or by the terms of this Agreement in accordance with Federal Acquisition Regulation 12.212 for civilian purposes and Defense Federal Acquisition Regulation Supplement 227.7202 for military purposes. The Software was developed fully at private expense. All other use is prohibited.